MULTI-PLAYER MISSION BUILDER 

3/13/97



[Introduction]



So, your vigilante blood has run sour, eh?  You've had it up to *here* with these nutty brawling areas and want to lay down your own.  Is that it?



Well, it ain't that easy.  It takes hard work, dedication and this document  Everyone should experience the joy, tears, anxiety and power that is the Interstate 76 Multi-Melee Mission Building Tool.



Now… this is not a refined piece of code.  It was originally created for internal use by the Interstate ’76 design team and is considered a beta tool, but we wanted to share it with all of the auto-vigilantes out there who want to create their own multi-player worlds.  Please do not call Activision Customer Support with questions about this tool.  Instead visit the Activision website at http://www.activision.com for information and updates regarding multi-player mission creation.  



[The Tool]



Create a folder on your hard drive and copy I76edit.exe (located in the BUILDER folder on Interstate ’76 Disc 1) into your new folder.  Double-click on I76edit.exe to launch the multi-player mission builder.  When you first open the tool, you will see a toolbar and menu bar.  You will also see the first toolbox (Elevation) already open.  



Regarding the menu bar, you will only need to use the Export and Exit commands from the File menu.  The other functions can be accessed through the toolbar.  FYI---the Help menu is not functional at all.



Here is a breakdown of what each button on the toolbar does…



NEW -- When you open the tool, a new mission screen is already laid out for you.  You do not need to click for a new one. **NOTE**  The tool will not prompt you to save your current mission when you open a new mission or exit the program.  Using the NEW button will erase your current mission, so remember to save your mission!  There is also a slight chance that the program will crash when creating a new mission screen over one that is already open.  It is therefore suggested that you exit the program before opening or creating a new mission if you already have a mission loaded. 



OPEN – This button should only be used when you first open the tool and want to edit an existing mission file. **NOTE**  The tool will not prompt you to save your current mission when you open an existing mission or exit the program.  Using the OPEN button will erase your current mission, so remember to save your mission!  There is also a slight chance that the program will crash when opening an existing mission over one that is already open.  It is therefore suggested that you only use the OPEN button when you first launch the tool and want to edit an existing mission.  If you want to edit a different existing mission, first save your current mission, exit the program, re-open the tool and then use the OPEN button to open the mission. 



SAVE – Use this button to frequently save your mission that is currently loaded.  Sometimes weird things can happen that will instantly wipe all of your hard work away, so use this function often.



The following toolbar buttons comprise the different “layers” of the mission.  Each layer can be toggled on or off to reveal or hide the objects/terrain it contains.  Each button launches its toolbox, the functionality of which is described below.  



[E] – This the Elevation layer.  Hitting this button will toggle the elevation points on and off and launch the elevation toolbox.  This layer does not display the terrain.  It only displays the elevation points, which are represented by big asterisks.   On the Elevation toolbox:



The first button, which looks like an asterisk, will set elevation points.  The box to the right is the elevation that will be set if you depress the button and click somewhere on the map. **NOTE** Sometimes buttons that are pressed will not do what they are suppose to do.  In this case, click that button twice to get it to work.



The second button, which looks like a target, is the rendering button.  After laying down elevation points, editing roads, placing objects or changing ANY feature in the mission, you need hit this button to see the changes you've made to the terrain (the program does not automatically refresh).  You also need to hit this button before exporting the mission.  This is one of the most used buttons in the builder.



The last button is the release button.  If you click this button and then the render button, it will give you the ultra-high resolution version of your mission map.  CAUTION:  This can take several hours to render… even up to a full day on a P90.  It is therefore recommended not to use this button at any time.



[T] – This is the Terrain layer.  It will toggle the actual terrain on and off.  When on, you see a topographical representation of the terrain and its various elevation.  On the Terrain  toolbox:



The first display is the elevation that the cursor happens to be over at the time.  Simply move your cursor over an elevation that you want to see and it appears in this little window.



The Raise Terrain and Lower Terrain options do not function very well and should not be used.



The Paint Terrain and Erase Terrain are very helpful.  Painting terrain consists of laying down a flat surface using the various brushes. **NOTE** Sometimes buttons that are pressed will not do what they are supposed to do.  Make sure that Paint Terrain or Erase Terrain is not only depressed, but has a little dotted "I'm selected!" box around it.  Also make sure you have a brush selected as well.  If any of this is not done, nothing will be painted.  **NOTE**  There is no undo function.  If you want to undo any painted terrain, just select Erase Terrain and erase what you did and visa versa for adding terrain.  Remember that when painting terrain, the center spot is not exactly under the mouse tip.  If you look at the mouse as being a graphic box, the center spot is actually in the lower left corner.  This can be confusing at first, especially when painting on very specific locations.



As for brushes, it is suggested to only use the ones on the left.  The brushes on the right were originally created to lay down hills with slopes on either side, but this functionally was never fully realized.  You can experiment with these brushes, but it is suggested to use only the ones on the left.  



The buttons along the bottom left lay down gradients.  If you find yourself with a road that is going over huge bumps, set down a gradient to create a smooth slope from its first point to its last.  The first button is a straight gradient.  Select it and click and drag from one place to another.  The second is a curved gradient. It will act just like a straight gradient until you use the fourth button (see info below).  The third button is the point-mover.  Select it and click on any gradient's point.  You can then move it around to a new location.  **NOTE**  Unlike roads, gradients do not lock together.  Instead you have to move each individually.  The fourth button is for curve adjustment.  Click on a curved gradient end and drag out in a desired direction.  If you are already familiar with Bezier curves, you should get the hang of this in no time.  The fifth button deletes a placed gradient.  Click on either end of the gradient to delete it.



If you want more visual detail than what is seen with the green grades, click the High radio button and click the box next to Repaint.  This will change the elevation map from repeating green patterns to a psychedelic techni-colored terrain that shows much more detail. Even though this uses many more colors, you can still have the coloring start at a higher point by typing it in the Starting Display Height in cm and then clicking Repaint.  The display height function only works when High is selected.  If your terrain is very eccentric, you will find that the extreme heights will turn into a black and white checkered pattern.



[S} – This is the Surface layer.  This shows the different surface qualities in the mission such as light vegetation (white), pavement (red), dirt road (yellow) and dirt (black).  Since the terrain and surface layers are graphical maps, both cannot be displayed at the same time.  One will replace the other as selected.  On the toolbox:



The surface type menu holds the various surfaces you can paint into your mission. **NOTE**  If you paint a road surface, such as packed dirt (road), paved (road), or wash (road), then you are quite likely to crash the game in single-player melee.  Do not do this if you value your audience's patience with your missions.  It is recommended using just the left three:  dirt (non-road), rocky or vegetation.



You can alter the different attributes below the surface type, but do so at your own risk.  If you choose to do this, only do so in small increments.



The Default Surface Type is what the surface will be in areas that you do not paint.  The default is light vegetation, the effects of which usually cause players to slide around too much, thus causing chassis reinforcement damage.  It is suggested to paint over high-risk areas with dirt so as to not to worry about setting a default surface type. 



Ignore the cliff stuff.  It is not applicable to multi-player missions and therefore useless. 



As for brushes, they work just like the ones in the Terrain toolbox.  The blank square is actually a selection square of sorts.  Set the type of surface you want to lay down and then depress the square.  Click and drag over an area and the subsequent box created between the two points will be filled with that new surface.



[P] – This is the Paths layer, which is not applicable to multi-player missions.  It is therefore useless. 



[R] – This is the Road layer.  This will display all of the roads in the mission.  Click to toggle them on and 

off.  On the toolbox:



The first button, marked with a straight line and sparkle, lays down straight roads.  It is very important to lay straight lines up to the edges of intersection objects.  Otherwise there will be cracks in your road -- severe cracks.  You may want to try laying down short little straight lines off of the intersection and then connect curved lines to the end of the protruding straight lines.  Make sure the curve adjustment line coming off of the curved road points is the exact same direction as the straight road to which it is connected.  Otherwise, the pavement will be appear incorrectly at the connection of the straight and curved roads.



The second button, marked with a curved line and sparkle, creates curved roads.  See the above paragraph for details on curved roads.



The third button, marked with a geometric angle, is used to move around roads.  **NOTE**  When one road gets close to another, it will automatically grip onto it and connect.  To avoid this, hold down the control key, which will also allow you to disconnect roads already locked together.  This will allow for free movement without too much fuss.  Roads must be very carefully placed next to intersections, which are separate objects and do not automatically connect with roads.  



The fourth button is for adjusting the curve in curve-able roads.  With this button depressed, click on the end of a road and pull out its curve adjustment line.  **NOTE**  When attaching roads together, make sure that the curve lines line up, otherwise you may have cracks in your roads where they connect.



The final button is for deleting roads.  Click on the end of a road to delete it.  If you are trying to delete a road that is connected at both ends, use the move tool and the control key to break the road away and then use the delete tool to delete the road.



Use the drop down menu to select the type of road to lay down. **NOTE**  Sometimes the road type displayed in the box will not match the actual road you are laying down.  To fix this, re-select the type of road before laying it down.  To change the type of a road without deleting it or renaming it, use the move tool to move the line a bit (this will select the line even though you might not visually recognize this), then change the road type in the menu to the desired road type you want the selected road piece to become.   



The buttons at the bottom were originally designed for four lane roads, which were cut from the game.  It is suggested not to use these buttons at any time.  



[O] – This is the Object layer.  This layer displays all of the objects including intersections but excluding vehicles.  Click to toggle this layer on and off.  On the toolbox:



The first button is for laying down a new object.  **NOTE** NEVER lay down a new object without first selecting another object.  When you select an object already laid down and then use this button, it will duplicate the selected object.  If you do not have an object selected prior to laying down a new one, the new object may contain gibberish.  If you ever find an object with weird ASCII codes, DELETE IT IMMEDIATELY!  The only exception to laying down a new object without selecting one first is if it is the first object you lay down in the mission.  Afterward, try to spawn every object off of another and then modify its attributes.  See below for general rules about creating and moving objects below.



The second button is for moving objects around. **NOTE**  Occasionally, moving an object between grid lines will cause the object to change sizes, become corrupt or crash the tool.  See below for general rules about creating and moving objects below.



The third button with the circular arrow is used to rotate the objects to face different directions.  Some objects such as road intersections and bridges can only be rotated to 90 degree angles.



The fourth button is for deleting unwanted objects.



The dist-X/length and the dist-Z input fields are for entering the length and width of an object  You should only input the sizes of objects in the grid.  A current grid of objects, their Object Class File names and Object Class IDs are available at http://www.activision.com/i76 in the auto-vigilante's guide to multi-melee combat.



The Object Label field is not needed in the creation of multi-melee areas, but you can use this to clarify the names of specific objects or help separate one object from another similar object.  Think of it as an extra space for your own reference.



The Object Class File is the name of the physical object called up into the world by the actual simulation. You can find this in the grids at http://www.activision.com/i76.



The Object Class ID specifies how the simulation will handle the object you are placing. Only use the class ID suggested in the grids at http://www.activision.com/i76.



The buttons across the bottom are for laying down stringed objects such as fences and barriers.  These were not used in any of the multi-player missions because of the restrictions placed upon them.  For example, you can only lay down about 20 meters at a time, which is a relatively very small amount.  Anything longer than 20 meters will cause problems in the simulation.  It is suggested not to use this feature, but you can experiment with it if you want to take the risk. 



RULES TO CREATING AND MOVING OBJECTS



1)  Never create an object without selecting one first unless it is the first object placed in the mission.  You may crash otherwise.

2)  Never move an object over the grid lines. You may crash otherwise.

3)  Before placing and moving objects around, turn on the grid.  Keep in mind how close your objects are to the grid and never move them over the grid lines.

4)  The bottom left corner of the object is the object’s actual placement in the world.  This is the point that should not cross over grid lines.  Objects can overlap onto grid lines as long as it is not the lower left corner.  **NOTE**  The lower left hand corner will change if you rotate the object.

5)  Do not move an object into another grid square.  Instead delete it, select another object and then create a new object into the desired grid square.  Make sure the attributes are set correctly.  



[V] – This is the Vehicle layer.  This layer displays all of the vehicles.  Click to toggle them on and off.

Vehicles are objects with their own layer.  Please follow ALL of the rules listed above that apply to objects.



In relation to multi-player missions, the purpose of the vehicle is to lay down the SPAWN points and REGEN points in a mission.  A SPAWN point is where players will enter the game.  If you rotate the SPAWN vehicle, the rotation will apply to the person who spawns into the game.  The REGEN vehicle marks where players can drive into a bunker and re-spawn with full weapons and health.  To set a spawn point, enter the word SPAWN into the Vehicle Class File.  For a regeneration point, enter the word REGEN.  Here are the Vehicle toolbox specifics:



The first button is for laying down new vehicles.  Click on it and then the map where you want the vehicle to be placed.



The second button moves the vehicles around.  Remember to avoid moving a vehicle or object over a grid line.



The third button is for rotating the vehicle.  A spawned vehicle will enter the game at whatever direction the spawn point is facing.



The fourth button is for deleting unwanted vehicles.



The Vehicle Label field is not used in multi-player missions.  Only use this field if you want to label a vehicle for your own reference.



The Vehicle Class File is to specify what kind of vehicle point you are placing, which will either be SPAWN or REGEN.



This Team Affiliation field is not relevant in the creation of multi-player missions.  Just leave it as Neutral.  The Vehicle Type does not matter either.  Just leave it as Car.  Also leave the Vehicle Control Source as AI Control.



[#] – The button with the grid in the center will toggle the grid on and off.  Each square in the grid is 640 meters by 640 meters.  The inner grid is split up into 5 meter increments.  You cannot place an object more specific than into the 5m grid.  Please remember that 640 meters is an extremely large area.  The average multi-melee mission included with the game occupies roughly no more than 9 grid squares, the average being 4 grid squares.  The general rule is to keep it small, fast and fun. **NOTE**  Sometimes elevation will change along the grid lines, which you can see in the terrain map.  



[Magnifying Glasses] – These buttons allow you to zoom in and out of the map depending on which button you hit.  Do not place things in the mission unless you have zoomed in at least 2x the default magnification.



[W] – This launches the toolbox for setting world definitions such as palette and luma table.  **NOTE** You cannot click in the field and enter values.  Rather you have to click Browse and type in the name.  



Here is an example of a standard options as seen in the settings for mission m05 (Slick Track):

 

T07.ACT		Palette File

T07.LUM		Luma Table

T07.TBL		Xlucency Table 1

M05.NPT		Objectives File

NK_1CLD1.MAP	Sky Texture

*NGSCRNG1.SDF	Scrounge Texture

TT031SD_MAP		Surface Texture

*ZMAP6M00.MAP	Level Map



*It is recommended that these remain as the default.  However, you can look at the grids at http://www.activision.com/i76 for specific mission palettes you might want to try. 



The Level Description field is where you enter the name of your mission.  This name will appear in the mission lists in the Multi-Melee shell screens in the game.



The Music Track field allows you to select which music track will be played during the mission.  Using a standard CD player, listen to Interstate ’76 Disc 2, find a track you like and then enter the track number into the field.



The Time of Day must correlate with the palette or you will not be able to see anything in the mission.  Check the palette grid in the multi-melee creation area at http://www.activision.com/i76.



Typically the far clip distance is set to 600, which is the recommended distance.  Adjusting it may cause problems when the mission is launched in the game.  Experiment at your own risk.



The Grid Deletion button is used to delete an entire grid area and its contents.  Click on the button and then the grid area you want to delete.  A dialog box will appear afterward.  Click on OK to then delete the entire grid.  Make sure you first save your mission in case you do not like the change.



LAUNCHING YOUR MISSION



Do the following to launch a homemade mission:



Use the render function in the tool to refresh the screen.

Save your mission.

Export your mission using the Export function in the File Menu.

Copy the .LVL and .TER files into the ADDON directory located in the directory you installed Interstate ’76.

Launch the game as you normally would and enter the multi-melee selection screen.  Your mission will be listed in addition to the ones included with the game.  Select your mission and launch the game as you normally would.





